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Preface

INTRODUCTION

This chapter contains general information about this user’s guide and customer support 

that will be useful prior to using the PICDEM™ Mechatronics development kit. Items 

discussed in this chapter are:

• Document Layout

• Conventions Used in this Guide

• Warranty Registration

• Recommended Reading

• The Microchip Web Site

• Development Systems Customer Notification Service

• Customer Support

• Document Revision History

• Troubleshooting

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 

documentation are constantly evolving to meet customer needs, so some actual dialogs 

and/or tool descriptions may differ from those in this document. Please refer to our web site 

(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 

page, in front of the page number. The numbering convention for the DS number is 

“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 

document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 

Select the Help menu, and then Topics to open a list of available on-line help files.
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DOCUMENT LAYOUT

This document describes how to use the PICDEM™ Mechatronics Demonstration 

Board. The manual layout is as follows:

• Chapter 1: PICDEM Mechatronics – An overview of the PICDEM Mechatronics 

Demo Board. PCB layout, parts and how to connect the provided jumper wires to 

the board.

• Chapter 2: Example Projects – Projects that describe how to read the sensors 

on the board, drive the LCD and control several motors. These motors include a 

Brushed DC (BDC) motor and a bipolar stepper motor.

• Chapter 3: Troubleshooting – Provides resolutions for solving common 

problems associated with using the PICDEM Mechatronics Demo Board.

• Appendix A: Hardware Schematics – Illustrates the PICDEM Mechatronics 

Demo Board hardware schematic diagrams.

• Appendix B: LCD Segment Mapping Worksheet – Provides the LCD Segment 

Mapping Worksheet.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS 

Description Represents Examples

Code (Courier font):

Plain characters Sample code

Filenames and paths

#define START
c:\autoexec.bat

Angle brackets: < > Variables <label>, <exp>

Square brackets [ ] Optional arguments MPASMWIN [main.asm]

Curly brackets and pipe 

character: { | }

Choice of mutually exclusive argu-

ments; An OR selection

errorlevel {0|1}

Lowercase characters in 

quotes

Type of data “filename”

Ellipses... Used to imply (but not show) addi-

tional text that is not relevant to the 

example

list 
[“list_option..., 
“list_option”]

0xnnn A hexadecimal number where n is a 

hexadecimal digit

0xFFFF, 0x007A

Italic characters A variable argument; it can be either a 

type of data (in lowercase characters) 

or a specific example (in uppercase 

characters).

char isascii (char, 
ch);

Interface (Arial font):

Underlined, italic text 

with right arrow

A menu selection from the menu bar File > Save

Bold characters A window or dialog button to click OK, Cancel

Characters in angle 

brackets < >

A key on the keyboard <Tab>, <Ctrl-C>

Documents (Arial font):

Italic characters Referenced books “MPLAB® IDE User’s 

Guide”
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WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. 

Sending in your Warranty Registration Card entitles you to receive new product 

updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

It is recommended that you become familiar with the documents listed below, prior to 

using the PICDEM Mechatronics Demo Board.

PICkit™ 2 Microcontroller Programmer User’s Guide (DS51553)

Consult this document for instructions on how to use the PICkit 2 Microcontroller 

Programmer hardware and software.

MPLAB® ICD 2 In-Circuit Debugger User’s Guide (DS51331)

Consult this document for information pertaining to Microchip’s In-Circuit Debugger, 

MPLAB ICD 2. MPLAB ICD 2 utilizes the in-circuit debugging capability built into the 

Flash devices.

PIC16F91X Data Sheet (DS41250)

Consult this document for information regarding the PIC16F91X 28/40/44-pin 

Flash-based, 8-bit CMOS Microcontroller with LCD Driver device specifications.

PIC16F631/677/685/687/689/690 Data Sheet (DS41262)

Consult this document for information regarding the PIC16F631/677/685/687/689/690 

20-pin Flash-based, 8-bit CMOS Microcontroller device specifications.

PIC12F508/509/16F505 Data Sheet (DS41236)

Consult this document for information regarding the PIC12F508/509 8/14-pin 

Flash-based, 8-bit CMOS Microcontroller device specifications.

MPLAB® IDE, Simulator, Editor User’s Guide (DS51025)

Consult this document for more information pertaining to the installation and features 

of the MPLAB Integrated Development Environment (IDE) Software.

Mechatronics Design Center

The Mechatronics Design Center (www.microchip.com\mechatronics) provides a 

wealth of information on design applications involving Mechatronics. All documentation 

is in Adobe® Acrobat® (pdf) format.
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THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 

site is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the web site contains the following 

information:

• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 

latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 

support requests, online discussion groups, Microchip consultant program 

member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 

press releases, listing of seminars and events, listings of Microchip sales offices, 

distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 

products. Subscribers will receive e-mail notification whenever there are changes, 

updates, revisions or errata related to a specified product family or development tool of 

interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 

Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers and other language 

tools. These include the MPLAB C18 and MPLAB C30 C compilers; MPASM™ 

and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object linkers; 

and MPLIB™ and MPLAB LIB30 object librarians.

• Emulators – The latest information on Microchip in-circuit emulators. This 

includes the MPLAB ICE 2000 and MPLAB ICE 4000.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 

debugger, MPLAB ICD 2.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 

Integrated Development Environment for development systems tools. This list is 

focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager 

and general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 

the MPLAB PM3 and PRO MATE® II device programmers and the PICSTART® 

Plus and PICkit™ development programmers.
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

• Development Systems Information Line

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers. A listing of 

sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY

Revision A (May 2005)

• Initial Release of this Document.

Revision B (June 2005)

• Changed PIC® Communicator to PIC® MCU Communicator.

Revision C (September 2006)

• Changed AN0 to C1- 

• Changed J2 to J1

• Changed J12 to J13

TROUBLESHOOTING

See Chapter 3 for information on common problems.
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Chapter 1.  PICDEM™ Mechatronics

1.1 INTRODUCTION

The PICDEM™ Mechatronics is intended to be a learning tool for individuals interested 

in Mechatronic design. Mechatronics refers to integrating electronic controls into 

mechanical systems or replacing mechanical components with an electronic solution.

PICmicro® microcontrollers are ideal for use in Mechatronic systems due to their small 

size, high efficiency, speed and abundance of peripheral configurations. Mechatronic 

systems range in complexity from a simple electromechanical switch with output 

multiplexing to the complex stabilizer control of a supersonic jet. The appliance and 

automotive markets are notable markets in which mechatronic designs are becoming 

more common place. The modern washing machine, for instance, once an entirely 

mechanical design, incorporates microcontrollers to manage cycle times, read human 

inputs and regulate the speed of the agitate and spin cycles.

This chapter introduces the PICDEM™ Mechatronics development board. It describes 

the PCB layout, parts and electrical connection to the PICkit™ 2 Flash Programmer 

and MPLAB ICD 2 In-Circuit Debugger. 

1.2 HIGHLIGHTS

This chapter discusses:

• Quick Start Guide

• The PICDEM™ Mechatronics Development Kit Contents

• The PICDEM™ Mechatronics Layout

• Required Tools

• PICDEM™ Mechatronics Setup

• General PICDEM™ Mechatronics Information
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1.3 QUICK START GUIDE

The PICDEM Mechatronics Demo Board is programmed at the factory with a 

demonstration program. The board must be configured as described in this chapter in 

order to use the demonstration program. Once the board is configured and powered 

up, the speed of the Brushed DC (BDC) motor on the board may be varied using the 

potentiometer (POT1). The 8-bit hexadecimal interpretation of the position of POT1 is 

displayed on the LCD.

Board Setup

Using the provided wire jumpers, screwdriver and shunts (2-pin black hard plastic 

jumpers), configure the board as shown in Figure 1-1.

1. Attach the leads of the Brushed DC motor to Drive 1 and Drive 2 using the 

screwdriver. 

2. Connect POT1 (on J4) to C1- (on J13) using a wire jumper.

3. Connect P1 (on J1) to RD7 (on J10) using a wire jumper.

4. Connect N2 (on J1) to RD2 (on J10) using a wire jumper.

5. Connect the right and center pins on JP8 using a shunt.

Board Power-Up

Supply power to the board in one of the following ways:

• Connect a 9-12 VDC (0.75 amp minimum) supply using J9 (see note below)

• Connect a 9-12 VDC (0.75 amp minimum) supply to the P21 and P20 screw 

terminals.

• Connect a 9 VDC battery to the battery connector.

• Connect a 5 VDC (1.2 amp minimum) supply to TP2 or TP3.

Demonstration Program

Press CLR FAULT (SW5), which is near the bottom right corner of the board. Turn 

POT1 clockwise to increase the speed of the motor. Note that the number displayed on 

the LCD increases as you turn the potentiometer clockwise.

Try experimenting with the other sensors on the board:

• Move the jumper wire on POT1 (J4) to Light (J4). Vary the intensity of light shining 

on the light sensor located near the top left corner of the board. Notice what 

happens to the motor.

• Move the jumper to TEMP (J4). Blow on the temperature sensor located on the 

top left corner of the board. Note what happens to the number displayed on the 

LCD.

• Move the jumper back to POT1. Move the jumper from N2 (J1) to D0 (J14). Watch 

what happens to the intensity of LED D0 as you turn the potentiometer.

Note: The power supply part number is AC162039 (see buy.microchip.com). Packaged 

with the MPLAB ICD 2, the part number is DV164007.
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FIGURE 1-1: QUICK BOARD SETUP

T
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1.4 PICDEM™ MECHATRONICS DEVELOPMENT KIT CONTENTS

The PICDEM™ Mechatronics Development Kit contains the following items:

1. The PICDEM™ Mechatronics Printed Circuit Board (PCB) with motors

2. Pre-programmed PIC16F917 PICmicro® device

3. 10 wire jumpers

4. 8 2-pin shunts

5. CD-ROM including:

• PICDEM™ Mechatronics User’s Guide

• Workshop-in-a-Box presentation for training students on the board 

(speaker notes included)

• Data sheets for the PIC16F91X, PIC16F631/677/685/687/689/690 

and motors

• Application notes and other technical documentation

6. Sample kit including a PIC16F690 and PIC12F509 device

7. Microchip screwdriver

8. Registration Card

1.5 PICDEM™ MECHATRONICS LAYOUT

The PICDEM™ Mechatronics is shown in Figure 1-2.

A PIC16F917 microcontroller is populated in the 40-pin socket, in which 22 out of the 

36 available I/O pins are dedicated connections to several components on the board. 

The remaining 14 pins are available for the user to connect to the other components on 

the board, using the provided jumper wires. The dedicated connections connect to the 

following components:

• Switch 1 – 1 pin: MCLR

• LCD – 17 pins: VLCD1, VLCD2, VLCD3, COM0, COM1, COM2, COM3, SEG0, 

SEG1, SEG2, SEG3, SEG6, SEG11, SEG16, SEG21, SEG22, SEG23

• In-Circuit Serial Programming™ Connector – ICSPDAT, ICSPCLK, MCLR

• RS-232 COM port – 2 pins: RX, TX

A 20-pin socket is provided and is compatible with 8/14/20-pin Flash-based 

microcontrollers. A PIC16F690 microcontroller is provided to use in the 20-pin socket, 

in which 5 out of the 18 available I/O pins are dedicated connections to several 

components on the board. The remaining 13 pins are available for the user to connect 

to the other components on the board using the provided jumper wires. The dedicated 

connections connect to the following components:

• Switch 1 – 1 pin: MCLR

• In-Circuit Serial Programming (ICSP™) Connector – ICSPDAT, ICSPCLK, MCLR

• RS-232 COM port: RX, TX

Dedicated pins are indicated by a white box enclosing the pin designation next to each 

socket. Pay close attention to this designation, as the functionality of the dedicated pins 

are affected by the circuitry these pins are connected to. It is recommended that you 

use only the pins not designated as dedicated connections in your design.

The remaining components on the board must be connected to the microcontroller 

using the provided wire jumpers. The jumpers connect between the headers on either 

side of the microcontroller and the header pins next to the respective components on 

the board. The components on the board are labeled in Figure 1-2.

Note: Only one microcontroller should be loaded into the board at any given time.



P
IC

D
E

M
™

 M
e

c
h

a
tro

n
ic

s

©
 2

0
0

6
 M

ic
ro

c
h

ip
 T

e
c
h

n
o

lo
g

y
 In

c
.

D
S

5
1

5
5

7
C

-p
a

g
e

 1
1

F
IG

U
R

E
 1

-2
:

P
IC

D
E

M
 M

E
C

H
A

T
R

O
N

IC
S

 D
E

M
O

 B
O

A
R

D
 H

A
R

D
W

A
R

E

1

2

3

4

5

6

7

8

9

10

11

12

13

14
15

16
17

18

19

20

Legend:

1. 40-pin socket

2. 20-pin socket

3. On-board voltage regulator and 

power connections

4. 8 LEDs

5. 39 segment LCD connected to 14 

pins on the 40-pin socket

6. RS-232 socket and associated 

hardware

7. Temperature sensor

8. Light sensor

9. 2 potentiometers

10. 32.768 kHz crystal

11. 4 tactile switches

12. In-Circuit Debugger (ICD) connector

13. In-Circuit Serial Programming™ 

(ICSP™) connector

14. Over-current protection circuit with 

Reset switch

15. 4 half-bridge MOSFET drives with 

associated MOSFET drivers and 

logic

16. Current sense for output stage

17. Back Electromagnetic Force (EMF) 

sense

18. Optical Interrupter for detecting the 

speed of the Brushed DC motor

19. Brushed DC motor

20. Stepper motor

21. Drive screw terminals

22. 9 VDC battery

22

21



PICDEMTM Mechatronics Demo Board User’s Guide

DS51557C-page 12 © 2006 Microchip Technology Inc.

The reasons for requiring you to use the provided jumpers to connect components to 

the microcontroller are three-fold.

1. You will gain knowledge and experience by physically connecting components to 

the microcontroller.

2. There are more peripherals than pins on the microcontrollers so that you can do 

more with the board.

3. Should you choose to use the board to experiment on your own, the board allows 

you the flexibility to do so. You can try experimenting with peripherals not 

covered in the projects in Chapter 2. “Example Projects”.

1.6 REQUIRED TOOLS

One of the following programming tools is needed in order to complete the projects in 

the next chapter:

• PICkit™ 2 Microcontroller Programmer (Part# DV164120)

• MPLAB® ICD 2 In-Circuit Debugger/Programmer (Part# DV164007 includes a 

9 VDC power supply and serial cable)

Figures 1-3 and 1-4 illustrate how to connect each of these tools to the PICDEM 

Mechatronics Demo Board.

1.7 PICDEM™ MECHATRONICS SETUP

Please take a moment to review the following steps, prior to using the board. These 

steps ensure the board is configured correctly before beginning the projects.

1.7.1 Jumper Settings

Remove all 2-pin shunts (jumpers), except for JP8. On JP8, the shunt should be 

connected in the right most position (indicated by the “+5V” label), which ensures that 

the drive stage is powered by +5 VDC.

1.7.2 Board Power-Up

Supply power to the board in one of the following ways:

• Connect a 9-12 VDC (0.75 amp minimum) supply via J9. The connector’s polarity 

is grounded externally and positive internally.

• Connect a 9-12 VDC (0.75 amp minimum) supply to the P21 and P20 screw 

terminals.

• Connect a 9 VDC battery to the battery connector.

• Connect a 5 VDC (1.2 amp minimum) supply to TP2 or TP3.

When power is initially connected, the “PWR ON” LED should light up. The “FAULT” 

LED in the over-current sense circuit will also be on when the board is powered up. 

Clear the Fault by pressing SW5 (CLR FAULT) switch. The board is now properly 

configured for the projects.
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FIGURE 1-3: CONNECTING THE MPLAB ICD 2 TO THE PICDEM 

MECHATRONICS DEMO BOARD

FIGURE 1-4: CONNECTING THE PICkit™ 2 TO THE PICDEM 

MECHATRONICS DEMO BOARD
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1.8 GENERAL PICDEM™ MECHATRONICS DEMONSTRATION BOARD 
INFORMATION

Power Supply Maximum Ratings

Supply voltage: 12 VDC

Output current (drive stage): 1.2A (total)

1.8.1 Experimentation

The PICDEM Mechatronics Demo Board was designed for your experimentation. After 

completing the projects in Chapter 2. “Example Projects”, please experiment freely 

on your own. Voltage power supplies and motors, other than those provided in the kit, 

may be used.

The driver portion of the board (the part that supplies power to the motors) has an 

over-current sense circuit and will trip should the motor draw more than 1.2 amps. The 

LM7805 regulator also protects the circuit by limiting the current consumed by the 

board. Logic has also been put in place to ensure that the P and N-Channel MOSFETs 

connected to each of the output drives can not be turned on simultaneously.

1.8.2 On-Board Status LEDs

There are eight status LEDs on the board specifically provided to assist the user in the 

developing and debugging of your code. The user can output register values on one of 

the Ports of the microcontroller and have a binary reading of the value of that register. 

Connect the LEDs as shown in Figure 1-5. For instance, if it is suspected that the 

STATUS register is not being set appropriately, move the STATUS value into PORTC. 

If PORTC is attached as shown in Figure 1-5, the LEDs will show the value of STATUS.

Note: Although reasonable measures have been taken to protect the board from 

the occasional mistake, THE BOARD MAY BE DAMAGED if proper design 

techniques are not used and special attention to the schematic is not made.
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FIGURE 1-5: CONNECTING PORTC PINS TO LEDS FOR DEBUGGING

1.8.3 OVER-CURRENT PROTECTION CIRCUIT

The over-current protection circuit included on the board shuts down the drive portion 

of the circuit if the board drives 1.2 amps continually for 100 ms or longer. Upon 

powering up the board, the “FAULT” LED will be on. The drive circuit must be reset 

manually by pressing the CLEAR FAULT button in the lower right hand portion of the 

board every time the board is initially supplied with power. Otherwise, a Fault is present 

when the “FAULT” LED is illuminated and must be manually reset by pressing the same 

button. If you use your own motor, keep current draw less than 1.2A, as the 

over-current protection circuit will not allow driving a motor at or above this rating.

1.8.4 MOTOR CONNECTION

The motors provided on the PICDEM Demo Board must be manually connected to the 

Drive screw terminals. The kit includes a Microchip screwdriver to facilitate in making 

these connections.

1.8.5 SERIAL COMMUNICATION

The JP2 jumper is normally not populated with a shunt. With no shunt present, the 

board is configured for serial communications via the PICmicro® USART (or EUSART). 

Connecting a shunt between the bottom two pins (TX and RX) allows the user to 

transmit and receive serial communication via one pin (jumper between the 

microcontroller and the TX/RX pin on JP2).

Note: The supplied Brushed DC motor and Bipolar Stepper motor are subject to 

change as the motor manufacturers cannot guarantee the same model 

numbers will be available indefinitely. Please refer to Microchip’s web page 

(www.microchip.com) for the current data sheets for the motors supplied 

with this kit, if the motor supplied on your board differs from the motor data 

sheets found on the CD-ROM.
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1.8.6 SNAP-OFF SENSORS

The temperature sensor and light sensor can be snapped off to give greater flexibility 

in using these sensors. For example, the temperature sensor may be snapped off and 

moved into a more hostile environment, while keeping the board within sight. Once, 

snapped off, solder wires of the same length between the adjoining holes (i.e., JP3 and 

JP4 for the temperature sensor) on the PICDEM Mechatronics Demo Board and the 

sensor board.

1.8.7 BACK EMF SCALING RESISTORS

If choosing to drive your own Brushed DC motor with the PICDEM Mechatronics Demo 

Board at a voltage higher than +5 VDC, the Back EMF must be scaled down into a range 

of 0-5 VDC. Resistor locations, R55 and R56, are provided for this purpose. These 

locations may be populated with resistors to create a simple voltage divider circuit. TP1 

is the output of this voltage divider. See the schematic in Appendix A. “Hardware 

Schematics” for further clarification.

1.8.8 CURRENT SENSE

The output stage of the board incorporates a simple current sensing circuit, which is 

assessable at J15 (CURRENT SENSE). At this pin, the voltage is equal to current 

± 10%. For instance, if a motor is being driven and it is drawing 0.9 amps, the voltage 

at the header is 0.9 volts (± 10%).
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1.8.9 HEADER/JUMPER FUNCTIONS

TABLE 1-1: HEADER/JUMPER FUNCTIONS

Header/

Jumper #
Description

J1* Output MOSFET drive pins.

J2 Full-bridge drive circuit (Drives 1 and 2): Place three shunts vertically on 

these pins to create a full-bridge drive circuit incorporating Drives 1 and 2.

J3 Full-bridge drive circuit (Drives 3 and 4): Place three shunts vertically on 

these pins to create a full-bridge drive circuit incorporating Drives 3 and 

4.

J4* Temperature sensor, light sensor, potentiometers, 32.768 oscillator and 

switches signal pins.

J5* Right-side signal pins of the 20-pin DIP socket (U2, pins 11-20).

J6* Left-side signal pins of the 20-pin DIP socket (U2, pins 1-10).

J7* Optical interrupter feedback signal pins.

J10* Right-side signal pins of the 40-pin DIP socket (U1, pins 21-40).

J13* Left-side signal pins of the 40-pin DIP socket (U1, pins 1-20).

J14 LED connect pins.

J15* Current sense feedback from the drive stage.

J16* Back EMF feedback signal pins.

JP2 Single-pin serial communication jumper (see Section 1.8.5 “Serial 

Communication” for details).

JP8 Drive circuit voltage selection. See diagram on board.

* On these jumpers, the pins are connected in pairs horizontally. This allows 

one pin to be used for jumping to/from the microcontroller (using a wire 

jumper) and the other pin for probing the circuit with test equipment.
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NOTES:
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Chapter 2.  Example Projects

2.1 INTRODUCTION

The following projects cover basic mechatronic principles such as reading a sensor, 

interfacing to a LCD and driving a motor. These projects also provide examples of how 

to use the various PICmicro® microcontroller peripherals. The projects are presented 

sequentially so that you will build knowledge as you progress from one project to the 

next.

Those who are new to programming PIC® microcontrollers should pay special attention 

to the comments in the source code for each of the projects. Though these projects are 

not intended to teach you the Microchip Assembly language, you will be able to get a 

good grasp of Microchip’s Assembly language by reading the source code.

Microchip has published application notes and other documents covering the 

applications in each of these projects. These documents can be found on the provided 

CD-ROM. Any updates to the applicable documents are available on Microchip’s web 

site. Please reference these documents while exploring each of the projects.

Note: See Section 1.7 “PICDEM™ Mechatronics Setup” for instructions on 

how to setup the board to its “initial” condition prior to doing projects.
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2.2 LOADING PROJECTS IN MPLAB® IDE

The firmware for the projects is arranged in corresponding project folders in the install 

directory for the PICDEM Mechatronics CD. If you installed the CD in the default 

directory, the firmware for Project 1 is located in:

C:\PICDEM Mechatronics\firmware\Project1

Opening a Project

1. Start MPLAB IDE.

2. In the menu bar choose File -> Open Workspace.

3. Find the project folder.

4. Open the *.mcw file.

The project window for Project 1 is shown in Figure 2-1.

FIGURE 2-1: PROJECT WINDOW

2.3 EXAMPLE PROJECTS

PIC16F917 Projects:

• Project 1: Hello World (Light a LED)

• Project 2: Dusk Indicator Using the Voltage Comparator

• Project 3: Thermometer Using the Analog-to-Digital Converter

• Project 4: Digital Clock Using Timer1

• Project 5: Brushed DC Speed Control with Optical Encoder Feedback

• Project 6: Brushed DC Speed Control with Back EMF Feedback

• Project 7: Stepper Motor Control; Single Stepping, Half Stepping and 

Microstepping

• Project 8: PC Interface Using the USART

PIC16F690 Project:

• Project 9: Brushed DC Motor Control Using the ECCP
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2.3.1 Project 1: Hello World (Light a LED)

When learning to use a new computer language, the first practical lesson traditionally 

instructs the user how to print “Hello World” on the screen. Staying with tradition, this 

project will make your PICDEM Mechatronics Demo Board say “Hello World” in the 

most practical way a microcontroller can – lighting a LED.

Objectives

1. Use the PIC16F917 to read a tactile switch input.

2. Implement switch debouncing.

3. Toggle a LED when a switch is pushed.

Applicable Technical Documents

PICkit 1™ Flash Starter Kit User’s Guide (DS40051): Exercise 2

Jumper Configuration

• RD7 (J10) to D0 (J14)

• RA0 (J13) to SW2 (J4)

FIGURE 2-2: PROJECT 1: JUMPER DIAGRAM

FIGURE 2-3: PROJECT 1: SCHEMATIC
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